GraphicWriter lll
Version 2.0

Addendum

This document describes the differences between GraphicWriter III
version 1.1 and version 2.0. This addendum supplements the original
documentation.

[ Installation ||

These installation instructions replace those in the original documentation.

GraphicWriter III version 2.0 requires Apple IIGS System Software version
6. If you do not own System 6 you can purchase it from Quality
Computers (1-800-443-6697, ask for the “System 6 Book with Software” for
approximately $29.95) or contact your local user group.

Installing Onto 3.5" Disks

If you are installing GraphicWriter Il onto a hard disk drive, skip to the
next section titled “Installing Onto A Hard Disk Drive.”

If you are running your system with 3.5" disks (e.g. one startup disk with
System 6 and some other program disk, such as GraphicWriter I1) then
follow these instructions exactly to begin using GraphicWriter III:
® Start up your computer with your startup disk, and get to the
point where you can launch an application.
® Make sure the original disk labeled Graphic Writer III is not write-
protected. That is, make sure you cannot see through the hole in
the upper-right corner of the disk
® Insert the original GraphicWriter III disk (i.e. not a copy) and
launch the “Run.This.First” application.

@ When you are asked to do so, type your full name then click OK.

Soon Apple’s Installer window is displayed. However, you will not use it
because you are installing onto 3.5" disks. Therefore:

® Choose Quit from the File menu.
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At this point the GraphicWriter III application has been personalized on
your original disk. Now:

®

@ e

Write-protect the original disk (i.e. make sure you can see
through the hole in the upper-right corner of the disk).

Make a backup copy of the original disk.
Store the original disk in a safe place.

If desired, from your backup you can delete everything except
the “GraphicWriter” and “Icons” folders.

To start GraphicWriter III, open the “GraphicWriter” folder on your
backup copy, then double-click the “GraphicWriter” program icon.

Installing Onto A Hard Disk Drive

If you are installing GraphicWriter III onto 3.5" disks, go back to the
Drevious section titled “Installing Onto 3.5" Disks.”

Follow these instructions exactly to begin using GraphicWriter III:

®

@

®

@

Start up your computer and get to the point where you can
launch an application.

Make sure the original disk labeled GraphicWriter III is not write-
protected.

Insert the original GraphicWriter III disk (i.e. not a copy) and
launch the “Run.This.First” application.

When you are asked to do so, type your full name then click OK.

Soon Apple’s Installer window is displayed. The scroll box on the left side

of the
®

® Qe

@

window contains “scripts” that can be used.
The “Install GraphicWriter III” script is already highlighted, so just
click the Install button and GraphicWriter III will be copied to the
disk that was used to start up the computer. NOTE: If you want to
install GraphicWriter Il to some other disk, first click the Disk
button until the disk is displayed.
After GraphicWriter III is installed, click the Quit button.

Launch the “SoundPatch” utility to update the “Sound” Control
Panel (CDEV) so it displays all the defined sound events.

Click Continue when you are told, “You are about to update your
Sound Control Panel.”

After the SoundPatch utility quits, eject the original Graphic-
Writer III disk and store it in a safe place.

To start GraphicWriter III, open the “GraphicWriter” folder on your hard
drive, then double-click the “GraphicWriter” program icon.
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“ What’s Different In Version 2. ||

General

e The GraphicWriter III application icon is now contains everything you
need—the separate “GW.Resources” file can be deleted.

e Most of GraphicWriter III’s dialog boxes are now “moveable, modal”
dialog boxes, meaning you can move them around the screen.

Dialog boxes can be navigated using the keyboard. Return or Enter is a
shortcut for clicking the button with the extra ring around it. Escape or
GPeriod is a shortcut for clicking the Cancel button.

e The horizontal and vertical rulers now show marks every 1/16th inch
instead of every 1/10th inch.

e Dragging out a new guide while the screen is updating used to cause
the guide to be offset from the mouse position; now it stays under the
mouse.

e Select portions of code were re-written or optimized, squeaking out
some extra speed for certain operations.

e Much of GraphicWriter III was rewritten to use newer System features
(such as the Resource Manager), resulting in a smaller program on disk.

e When you double-click a GraphicWriter III document in the Finder,
GraphicWriter III is launched and the document is opened.

& (Apple) Menu

Help

e New feature! Choosing Help from the ® (Apple) menu opens a
window that displays help topics for GraphicWriter III. Select a topic
from the popup menu to read more about that topic.
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File Menu

Close

This menu item now responds to the standard GW shortcut key
(previously GW changed the View to Fit In Window...now use (0
(zero) to choose Fit In Window).

The “save changes” dialog box is redesigned.

Export / Import

When beginning an export or import, GraphicWriter III plays the sound
associated with the “beginning long operation” event. When the
process is complete the “operation complete” event sound is played.

Unless you assign a special sound to those events, it is likely that those
sounds will play the standard system beep—usually a “bonk” that is
sometimes heard when the system crashes. Do not panic when you
hear this sound! Instead, let the import/export operation complete,
then do the following:
® Choose Control Panels from the % (Apple) menu.
@ Open the “Sound” CDEV (scroll down if necessary to find it). The
system will gather the names of all the new sound events.
® Choose the “Beginning long operation” event and assign a nicer
sound to it, then do the same for the “Operation complete” sound
event. NOTE: If these events are not listed, run the “SoundPatch”
utility provided on the original Graphic Writer I1I disk.

Print

You are now notified if an error occurs while printing. NOTE: If you
manually cancel a print job you may be notified that an error occurred
while printing.

While printing, GraphicWriter III tells Twilight II to use background
(i.e. friendly) blanking if it decides to blank.
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Edit Menu

The standard system clipboard is now supported, so you can Copy and
Paste text and graphics between GraphicWriter III and other
applications or desk accessories.

Paste

If the system clipboard contains text, Paste lets you paste that text into
any typing frame (just as if you had copied the text from within
GraphicWriter IID).

If the system clipboard contains a IIGS PICTure (e.g. while in Platinum
Paint you copied an image to the clipboard, then you launched
GraphicWriter III) Paste inserts a new “picture” object into the
document. This picture object can be resized without losing any of its
original quality.

TIP: After copying a picture in Platinum Paint (or from a clipboard
NDA, etc.), paste it into Grapbic Writer IIl. While the new picture object
is selected choose Object Specs from the Object menu, then click the 1/2
or 1/4 button to reduce the picture to exactly 1/2 or 1/4 its original size.
This will yield exceptional print quality from bigh quality printers.

Currently there is no way to directly create or import a Picture object in
GraphicWriter III. To create a picture object you must copy a picture
from Platinum Paint, then Paste that picture into GraphicWriter II1.

Spelling

The dialog box has been changed to provide a much larger area in
which to display the context of the spelling error.

Most of the spelling code has been rewritten, and we believe the
infamous “Possible Choices” bug has finally been squashed: Spell-
checking uses a lot of memory, and in version 1.1 the system would
hang if memory got too low when getting Possible Choices. In version
2.0 you will now get an “out of memory” message instead. Often,
saving your document is all that is required to resume spell checking
with no further memory errors.

Curly apostrophes are handled correctly. Previously don't (straight)
would not be shown as a suspect word, but don'’t (curly) would be.

The spell checker recognizes foreign characters and special symbols
correctly.

What'’s Different In Version 2.0 5



Preferences

The “Show Frames” option (checked by default) now shows dotted
lines around painting frames, as well as typing frames.

With this change, new painting frames now start with the Pen color set
to None (i.e. no border will be visible unless you select the Arrow tool,
click on the painting frame, then choose a Pen color).

Preferences are now stored in the “*:System:Preferences:” folder, or in
the user’s folder if using AppleShare.

Font Menu

The Font menu is now “standard” so it will work with utilities such as
our nifty “Super Menu Pack™!’

All the fonts available in your system are listed alphabetically on the
Font menu. The menu will be scrollable if you have more fonts than
will fit on the screen.

Choose Font

This option presents the standard Choose Font dialog box, where you
can select a Font, Style, and Size all in one step!

* Super Menu Pack is a “Control Panel Device” (or CDEV) that adds three

cool features to your IIGS-specific programs: a “hierarchic” Control
Panels menu item, a popup window that displays all the characters in
the font you're currently using, and a “pretty” font menu, where each
font name is displayed in that font’s style (e.g. Helvetica is shown in
Helvetica, Times in Times, etc.).
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Object Menu

Object Specs

e This new feature lets you position and size an object by exact numbers.

Object Specifications S0

Tog: Height: (3000 _] mé:)
Left:[BI_] Width: T30 ] " Za

Using the Arrow tool, click to select a single object, then choose Object
Specs from the Object menu. The object’s current position and size are
shown. Initially the Height and Width of the object is shown; click the
icon to display the Bottom and Right values.

Common reductions (1/2 and 1/4) and common enlargements (2x and
4x) are provided. Clicking one of the sizing buttons adjusts the Height
and Width based the values that were originally shown when the
dialog box was first opened. For example, clicking 1/2 reduces the
object’s Height and Width values to 50% of the values that were
originally shown—clicking 1/2 more than once does not continue to
reduce the value by 50%.

For most objects, clicking Original restores the values that were shown
when the dialog box was opened. The exception is Picture objects,
where clicking Original restores the size of the picture as it appeared
immediately after it was first pasted into the document.

What's Different In Version 2.0 7



Page Menu

Snap To Guides

e ‘The snapping code was greatly improved so that objects will snap to
the same position even if they are slightly left/right or above/below the
guide being snapped to.

Insert Pages

e In the document window, clicking “+” in the ‘- Page +” area moves to
the next page (as it did before). What’s new: If the last page of the
document is currently being shown, the “Insert Pages” dialog box
appears automatically so you can insert new pages.

Copy Master Guides

e This new feature erases all the guides on the current page, and
replaces them with an exact copy of all the guides from the
appropriate master page (see Master Pages in the original manual’s
index).

Extras Menu

e This menu is new, and only appears if there are GraphicWriter III
extras installed that ask to be added to this menu.

Currently there are no extras available, but the capability now exists to
extend Graphic Writer III’s functionality without having to release a
whole new version.
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